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Download and Installation

* The VBMS8 Toolbox runs within SPM8. That is, SPM8 needs to be installed and added to your
Matlab  search  path  before the VBM8 Toolbox can be installed (see
http://www.fil.ion.ucl.ac.uk/spm/ and http://en.wikibooks.org/wiki/SPM).

* Download (http://dbm.neuro.uni-jena.de/vbm8/) and unzip the VBMS8 Toolbox. You will get a
folder named “vbm8”, which contains various matlab files and compiled scripts. Copy the folder
“vbm8” into the SPM8 “toolbox” folder.

Starting the Toolbox
e Start Matlab

e Start SPMS3 (i.e., type “spm fmri”)

* Select “vbm8” from the SPM menu (see Figure 1). You will find the drop-down menu between the
“Display” and the “Help” button. This will open the VBMS8 Toolbox (in SPM’s 2nd window). You
can access the VBMS8 Toolbox menu by clicking on “VBM8” (located at the upper left corner of
this window; see Figure 2).
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Figure 1: SPM menu Figure 2: SPM’s 2" window with the VBMS
Toolbox menu



Basic VBM analysis (overview)

The VBMS8 Toolbox comes with different modules, which may be used for an analysis. Usually, a VBM
analysis comprises the following steps:

(a) Preprocessing:

1.

T1 images are normalized to a template space and segmented into gray matter (GM), white
matter (WM) and cerebrospinal fluid (CSF). The preprocessing parameters can be adjusted via
the module “Estimate and write”.

After the preprocessing is finished, a quality check is highly recommended. This can be
achieved via the modules “Display one slice for all images” and “Check sample homogeneity
using covariance”. Both options are located under “VBM8 > Check data quality”.

Before entering the GM images into a statistical model, image data need to be smoothed. Of
note, this step is not implemented into the VBMS8 Toolbox but achieved via the standard SPM
module “Smooth”.

(b) Statistical analysis:

4.

The smoothed GM images are entered into a statistical analysis. This requires building a
statistical model (e.g., T-Tests, ANOVAs, multiple regressions). This is done by the standard
SPM modules “Specify 2nd Level”.

The statistical model is estimated. This is done by the standard SPM module “Estimate”.

After estimating the statistical model, contrasts will be defined to get the results of the
analysis. This is done by the standard SPM module “Results”.

A few words about the Batch Editor...

As soon as you select a module from the VBM8 Toolbox menu, a new window (the Batch
Editor) will open. The Batch Editor is the environment where you will set up your analysis (see
Figure 3). For example, an “<-X” indicates where you need to select files (e.g., your image files,
the template, etc.). Other parameters have either default settings (which can be modified) or
require input (e.g., choosing between different options, providing text or numeric values, etc.).

Once all missing parameters are set, a green arrow will appear on the top of the window (the
current snapshots in Figure 3 show the arrow still in gray). Click this arrow to run the module
or select “File = Run Batch”. It is very useful to save the settings before you run the batch
(click on the disk symbol or select “File > Save Batch”).

Of note, you can always find helpful information and parameter-specific explanations at the
bottom of the Batch Editor window."

! Additional VBM8-related information can be found by selecting “VBM Tools website” in the VBM8 Toolbox menu. This
will open a website. Here, look for “VBM subpages” on the right.

3



All settings can be saved either as .mat file or as .m script file and reloaded for later use. The
.m script file has the advantage to be editable with a text editor.
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Figure 3: The Batch Editor is the environment where the analysis is set up. Left: For all settings
marked with “<-X”, files have to be selected (“Select Files”). Right: Parameters can be edited and

adapted (“Edit Value”).

Basic VBM analysis (detailed description)

1. Select your working directory.

ok N

Before running anything, it is recommended to always set SPM’s working directory:
“Utilities = CD” (right to the “Help” button in the SPM main menu). Select your working
directory and click “Done” to change the directory.

Open the VBM Toolbox.
Select the module you want to run.
Specify the parameters (see below).

Run the module.

Of note, for debugging, the relevant information can be printed by selecting “Print VBM debug information” from the
VBMS8 Toolbox menu.



Modules

FIRST MODULE: ESTIMATE AND WRITE

VBMS8 = Estimate and write

Parameters:

o Volumes <-X = Select Files = [select raw data] = Done

- Select one volume for each subject. As the Toolbox does not support multispectral
data yet (i.e., different imaging methods for the same brain, such as T1-, T2-,
diffusion-weighted or CT images), it is recommended to choose a T1l-weighted
image.

- Importantly, the images need to be in the same orientation as the template and
priors; you can double-check and correct via using “Display” in the SPM menu. By
default the MNI template is used (located in your SPM folder “spm8 > templates
-2 T1”)

o Estimation Options = [use defaults or modify]

The defaults provide a solid starting point for the analysis. If you prefer to use
your own customized Tissue Probability Maps (TPMs), you can specify / select
them here. However, the new segmentation approach in VBM8 does not
need tissue priors for the segmentation anymore. Customized TPMs will be
only used for the spatial normalization. Thus, creating your own TPMs might
be only appropriate for children’s data if they largely deviate from the
standard MNI template. In order to create your own TPMs the Template-O-
Matic (TOMS8) Toolbox can be used.

o Extended Options = [use defaults or modify]

Again, the defaults provide a solid starting point. The high-dimensional
DARTEL normalization is used as the default spatial normalization.
Alternatively, the low-dimensional SPM8 spatial normalization can be chosen.
Furthermore, remaining non-brain tissue can be removed more thoroughly by
setting the option “Clean up any partitions” to “Thorough Cleanup”. This is
particularly useful for very atrophic brains (e.g., as occurring in Alzheimer’s
disease). The parameters for two de-nosing methods can be also changed.
The optimal weighting for the SANLM filter is internally estimated. The MRF
weighting is not necessary to change, because the SANLM filter will have a
much larger de-nosing effect. Values of “0” will deselect both filters.

o Writing Options = [use defaults or modify]

For GM, WM, and CSF image volumes see page 14: “Additional Information
on native, normalized and modulated normalized volumes”. Note: The default
option “Modulated normalized — non linear only” will result in an analysis of
relative differences in regional GM volume, corrected for individual brain size.
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A bias corrected image volume, in which MRI inhomogeneities and noise are
removed, can be written in normalized or native space. This is useful for
quality control and also to create an average image of all normalized T1
images in order to display / overlay the results. Note: For a basic VBM analysis
use the defaults.

A partial volume effect (PVE) label image volume can also be written in
normalized or native space or as a DARTEL export file. This is useful for quality
control and also for future applications using this image to reconstruct
surfaces. Note: For a basic VBM analysis use the defaults.

The Jacobian determinant for each voxel can be written in normalized space.
This information can be used to do a Tensor-Based Morphometry (TBM)
analysis. Note: For a basic VBM analysis this is not needed.

Finally, deformation fields can be written. This option is useful to re-apply
normalization parameters to other images or particular regions of interest.
Note: For a basic VBM analysis this is not needed.

After setting all parameters, you will be able to save and run the module:

File > Save Batch [optionally save your model and selections as a *.m script file; the next time
you can simply load this *.m script file with “Load Batch”, and adjust / modify respective sections
if necessary].

File = Run Batch [the outcomes will be written to the same directory like the original data]. As
per defaults, the outcomes will be the bias corrected normalized volumes (wm*) and the tissue
segments (i.e., the modulated normalized gray matter (mOwrp1*) and white matter (mOwrp2)
segments of each volume). If you selected the low-dimensional spatial normalization approach the
modulated images will be named mOwp1l* for gray matter and mOwp2* for white matter. All
possible naming is summarized under “Naming convention of output files” (p. 17) and in the
graphics window of SPM, when the SPM8 Toolbox is started.

SECOND MODULE: DISPLAY ONE SLICE FOR ALL IMAGES

VBMS8 > Check data quality > Display one slice for all images

Parameters:

o Volumes <-X = Select Files = [select the new files] = Done

Select the newly written data [e.g. the “wm*” files, which are the normalized bias
corrected volumes]. This tool will display one horizontal slice for each subject, thus
giving a good overview if the segmentation and normalization procedures yielded
reasonable results. For example, if the native volume had artifacts or if the native
volumes had a wrong orientation, the results may look odd. Solutions: Use “Check
Reg” from the SPM main menu to make sure that the native images have the same



orientation like the MNI Template (“SPM - templates = T1”). Adjust if necessary
using “Display” from the SPM main menu.

o Proportional scaling = [use defaults or modify]
- Check “yes”, if you display T1 volumes.

Show slice in mm > [use defaults or modify]

- This module displays horizontal slices. This default setting provides a good
overview.

- File = Save Batch

- File = Run Batch [the outcomes will be displayed in SPM’s graphic window]

THIRD MODULE: CHECK SAMPLE HOMOGENEITY USING COVARIANCE

VBMS8 > Check data quality = Check sample homogeneity using covariance
Parameters:

o Volumes <-X > Select Files = [select gray matter volumes] - Done
- Select the newly written data [e.g. the “mOwrp1*” files, which are the normalized
(wr) GM segments (p1) modulated for the non-linear components (m0)]. This tool
visualizes the covariance between the volumes using a boxplot and covariance
matrices. Thus, it will help identifying outliers. Any outlier should be carefully
inspected for artifacts or pre-processing errors using “Check Reg” from the SPM
main menu.

o Proportional scaling = [use defaults or modify]
- Check “yes”, if you display T1 volumes.

o Show slice in mm = [use defaults or modify]
“Omm” means the center slice along the origin of the MNI template.

o Nuisance = [enter nuisance variables if applicable]

- For each nuisance variable which you want to remove from the data prior to
calculating the covariance, select “New: Nuisance” and enter a vector with
the respective variable for each subject (e.g. age in years). All variables have
to be entered in the same order as the respective volumes. You can also type
“spm_load” to upload a *txt file with the covariates in the same order as the
volumes.

- File = Save Batch
- File = Run Batch



- A boxplot window and covariance matrices will open, which depict the
covariance between the volumes; outliers can be displayed in SPM’s graphic
window. The covariance matrix shows the covariance between all volumes.
High covariance values mean that your data are more similar. The boxplot
summarizes all covariance values for each subject and shows the
homogeneity of your sample. A small overall covariance in the boxplot not
always means that this volume is an outlier or contains an artifact. If there are
no artifacts in the image and if the image quality is reasonable you don’t have
to exclude this volume from the sample. This tool is intended to utilitize the
process of quality checking and there is no clear criteria defined to exclude a
volume only based on the overall covariance value. However, volumes with
an overall covariance below two standard deviations are indicated and should
be checked very carefully.

FOURTH MODULE: SMOOTH

SPM menu = Smooth
Parameters:

o Images to Smooth <-X = Select Files = [select grey matter volumes] > Done

- Select the newly written data [e.g. the “mOwrpl” files, which are the
normalized (wr) grey matter segments (pl) modulated for the non-linear
components (m0)].

o FWHM - [use defaults or modify]

- 8-12mm kernels are widely used for VBM. To use this setting select “edit
value” and type “8 8 8” (or “12 12 12", respectively) for a kernel with 8mm
(with 12mm) FWHM.

o Data Type = [use defaults or modify]

o Filename Prefix = [use defaults or modify]

- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [the outcomes will be written to the same directory like the original data]



Building the statistical model

Although there are many potential designs offered in the 2nd-level analysis | recommend to use the
“Full factorial” design because it covers most statistical designs. For cross-sectional VBM data you
have usually 1..n samples and optionally covariates and nuisance parameters:

Number of factor levels Number of covariates Statistical Model

1 0 one-sample t-test

1 1 single regression

1 >1 multiple regression

2 0 two-sample t-test
>2 0 Anova

Ancova (for nuisance parameters) or

>1 >0 . .
Interaction (for covariates)

Two-SAMPLE T-TEST

SPM menu = Specify 2"-level
Parameters:

o Directory <-X = Select Files = [select the working directory for your analysis] = Done

o Design =2 “Two-sample t-test”

» Group 1 scans > Select Files > [select the smoothed grey matter volumes for
group 1; following this script

these will be the “smOwp1” files] You could specify one or many
- Done covariates (i.e., partial out the
= Group 2 scans > Select Files > variance of specific factors when

looking at group differences)
® (Covariates 2 New Covariate
® \/ector <-X = enter the values of

the covariates (e.g., age in years)
= Variance - Equal or Unequal in the same order as the

» Grand mean scaling = No respective file names or type
“spm_load” to upload a *.txt file

]

ANCOVA = No with the covariates in the same

[select the smoothed grey matter
volumes for group 2] > Done

* |ndependence = Yes

o Covariates’ order as the volumes
. ® Name <-X = Specify Text (e.g.,
o Masking “age”)

® |nteractions = None
® (Centering = No centering




» Threshold Masking = Absolute > [specify value (e.g., “0.1”)]
* Implicit Mask = Yes
= Explicit Mask = <None>

o Global Calculation = Omit

o Global Normalization
= Qverall grand mean scaling > No

o Normalization = None
- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [this will create an “SPM.mat” file in your working directory]

UsING THE FuLL FACTORIAL MODEL (FOR A 2x2 ANOVA)

SPM menu = Specify 2"-level
Parameters:
o Directory <-X = Select Files = [select the working directory for your analysis] = Done

o Design = “Full Factorial”

=  Factors =2 “New: Factor; New: Factor”
Factor
- Name -2 [specify text (e.g., "sex”)]
- Levels > 2
- Independence = Yes
- Variance = Equal or Unequal
- Grand mean scaling 2 No
- ANCOVA - No
Factor
- Name -2 [specify text (e.g., “handedness”)]
- Levels > 2
- Independence = Yes
- Variance = Equal or Unequal
- Grand mean scaling 2 No
- ANCOVA - No

= Specify Cells 2 “New: Cell; New: Cell; New: Cell; New: Cell”
Cell
- Levels = [specify text (e.g., “1 1”)]
- Scans > [select files (e.g., the smoothed GM volumes of the left-handed

males)]
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Cell

- Levels = [specify text (e.g., “1 2”)]

- Scans 2> [select files (e.g., the smoothed GM volumes of the right-handed
males)]

Cell

- Levels = [specify text (e.g., “2 1”)]

- Scans > [select files (e.g., the smoothed GM volumes of the left-handed
females)]

Cell

- Levels = [specify text (e.g., “2 2”)]

- Scans > [select files e.g., the smoothed GM volumes of the right-handed
females)]

. *
o Covariates

o Masking
» Threshold Masking = Absolute > [specify value (e.g., “0.1”)]
* Implicit Mask = Yes
= Explicit Mask = <None>

o Global Calculation = Omit

o Global Normalization
= Qverall grand mean scaling > No

o Normalization = None
- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [this will create an “SPM.mat” file in your working directory]
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MuLTIPLE REGRESSION (CORRELATION)

SPM menu = Specify 2"-level
Parameters:
o Directory <-X - Select Files = [select the directory for your analysis] = Done

o Design 2 “Multiple Regression”
= Scans -2 [select files (e.g., the smoothed GM volumes of all subjects)] = Done

= Covariates = “New: Covariate”

Covariate
- Vector - [enter the values in the same order as the respective file names of
the smoothed GM images]
- Name -2 [specify test (e.g, “age”)]
- Centering = No centering
- Intercept = Include Intercept
o Covariates
o Masking

» Threshold Masking = Absolute > [specify value (e.g., “0.1”)]
* Implicit Mask = Yes
= Explicit Mask = <None>

o Global Calculation = Omit

o Global Normalization
= Qverall grand mean scaling > No

o Normalization = None
- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [This will create an “SPM.mat” file in your selected folder]
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UsING THE FuLL FACTORIAL MODEL (FOR AN INTERACTION)

SPM menu = Specify 2"-level
Parameters:
o Directory <-X = Select Files = [select the working directory for your analysis] = Done

o Design = “Full Factorial”

» Factors = “New: Factor”
Factor
- Name -2 [specify text (e.g., "sex”)]
- Levels > 2
- Independence = Yes
- Variance = Equal or Unequal
- Grand mean scaling 2 No
- ANCOVA - No

= Specify Cells 2 “New: Cell; New: Cell”
Cell
- Levels = [specify text (e.g., “1”)]
- Scans =2 [select files (e.g., the smoothed GM volumes of the males)]
Cell
- Levels = [specify text (e.g., “2”)]
- Scans =2 [select files (e.g., the smoothed GM volumes of the females)]
o Covariates 2 “New: Covariate”
= Covariate
- Vector - [enter the values in the same order as the respective file names of
the smoothed GM images]
- Name -2 [specify test (e.g, “age”)]
- Interactions = With Factor 1
- Centering = No centering
o Masking

» Threshold Masking = Absolute > [specify value (e.g., “0.1”)]
* Implicit Mask = Yes
= Explicit Mask = <None>

o Global Calculation = Omit

o Global Normalization
= Qverall grand mean scaling > No

o Normalization = None
- File - Save Batch [this will save the parameters as *.m script file]

- File = Run Batch [this will create an “SPM.mat” file in your working directory]
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ESTIMATING THE STATISTICAL MODEL

SPM menu = Estimate
Parameters:

o Select SPM.mat <-X = Select Files = [select the SPM.mat which you just built] = Done
o Method = “Classical”

- File = Save Batch

- File = Run Batch [This will create an “SPM.mat” file in your selected folder]

DEFINING CONTRASTS

Defining Contrasts:

SPM menu > Results > [select the SPM.mat file] > Done (this opens the Contrast Manager) —>
Define new contrast (i.e., choose “t-contrast” or “F-contrast”; type the contrast name and specify the
contrast by typing the respective numbers, as shown below):

T-contrasts:

a. Simple group difference

= Use SPM.mat from model “2 sample T-test”
® For Group A > Group B: specify “1-1”
® For Group A < Group B: specify “1 1”7

b. 2x2 ANOVA

= Use SPM.mat from model “2x2 ANOVA”
®* For left-handed males > right-handed males: specify “1 -1 0 0”
®* For left-handed females > right-handed females: specify “00 1 -1”
®* For left-handed males > left-handed females: specify “1 0-1 0”
®* For right-handed males > right-handed females: specify “01 0-1”
etc.
®* For males > females: specify “11-1-1"
® For left-handers > right-handers: specify “1-11-1"

c. Multiple Regression (Correlation)
= Use SPM.mat from model “CORRELATION”

® For positive correlation: specify “1”
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®* For negative correlation: specify “-1”
d. Interaction

= Use SPM.mat from model “INTERACTION”
® Forregression slope Group A > Group B: specify “00 1 -1”
® Forregression slope Group A < Group B: specify “00-1 1”

- Done
F-contrasts:
If you would like to use the old SPM2 F-contrast “Effects of interest” the respective contrast vector is:
eye(n)-1/n

where n is the number of columns of interest. This F-contrast is often helpful for plotting parameter
estimates of effects of interest.

Getting Results:
SPM menu - Results = [select a contrast from Contrast Manager] > Done

® Mask with other contrasts = No
® Title for comparison: [use the pre-defined name from the Contrast Manager or change it]

® Pvalue adjustment to:
o None (uncorrected for multiple comparisons), set threshold to 0.001
o FDR (false discovery rate), set threshold to 0.05, etc.
o FWE (family-wise error), set threshold to 0.05, etc.

* Extent threshold: [either use “none” or specify the number of voxels?)

Workflows for VBM-analyses — special cases

Background
For most analyses the VBM Toolbox will supply all tools needed. That is, as the new segmentation

algorithm is not dependent on Tissue Probability Maps (TPMs) anymore and as predefined DARTEL-
templates for healthy adults exist, most questions can be assessed using the toolbox settings.
However, for some special cases such as analyses in children or special patient populations, the
toolbox settings might not be optimal. For these cases the VBM8 Toolbox provides an integration into

% In order to empirically determine the extent threshold (rather than saying 100 voxels or 500 voxels, which is completely
arbritrary), simply run this first without specifying an extent threshold. This will give you an output (i.e., the standard SPM
glass brain with significant effects). When you click “Table” (SPM main menu) you will get a table with all relevant values
(MNI coordinates, p-values, cluster size etc). Below the table you will find additional information, such as “Expected
Number of Voxels per Cluster”. Remember this number (this is your empirically determined extent threshold). Re-run SPM
- Results etc. and specify this number when asked for the “Extent Threshold”. There is also a hidden option in “VBM8 2>
Data presentation = Threshold and transform spmT-maps” to define the extent threshold in terms of a p-value or to use
the “Expected Number of Voxels per Cluster”.
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the SPM8 environment that can be used to optimize the preprocessing. In the following, we will
present strategies how to deal with these special cases.

Standard VBM preprocessing: Input, Output and where to modify

The first module of the VBMS8 Toolbox (“Estimate and Write”) processes all preprocessing steps
except for the smoothing. Basically, it takes structural volumes and TPMs as input. It will then
segment the data, apply a registration to MNI Space (either rigid or affine) and subsequently a non-
linear deformation. The non-linear deformation parameters can be calculated via the low dimensional
SPM default approach or the high dimensional DARTEL algorithm and the predefined templates.
Figure 1 depicts this preprocessing workflow and highlights possibilities where to modify.

VBMS8 —Toolbox: “Estimate and write”

SPM default VBMS8
TPMs DARTEL templates
}* |
Segmentation DARTEL
Native — normalization =  normalized
1 ( and s (VBMS8 templates) (modulated)
Volumes . - Grey Matter
affine OR rigid ‘ SPM default — segments
registration normalization
Affine OR rigid
= registered
segments

Fig. 1: Flow-chart of the preprocessing steps within the module “Estimate and Write”.
Marked in red are those steps, where the preprocessing can be customized. Note that
the built-in DARTEL normalization always works with the VBM8 DARTEL templates of
550 healthy adult control subjects. Affine or rigid registered volumes can be used to
create customized DARTEL-templates.

Adapting the workflows

Customized Tissue Probability Maps - overview

For data on children it will be a good idea to create customized TPMs, which reflect age and gender of
the population. The TOMS8 Toolbox (available via: https://irc.cchmc.org/software/tom.php) provides
the means to customize these TPMs. To learn more about the TOM toolbox, see also
http://dbm.neuro.uni-jena.de/software/tom/.
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Customized Tissue Probability Maps

About the TOMS8 Toolbox:

-2 select Module “create new template”
-2 select “TOM.mat” (you will have to download this file together with the toolbox)
- write priors/template as single file
- for all others use default settings or modify. For “Age” either a vector or a mean age

(when using the average approach) must be specified.

Implementation into VBMS8:

Module: “Estimate and write”
—->”Estimation Options”.

- Tissue Probability Maps (= Select your customized TPMs here)

Customized DARTEL-template - overview

For all cases that include at least 50-100 subjects a customized DARTEL template can be created. That
is, grey matter and white matter tissue segments of all subjects are used to create a mean template of
the study sample. As the VBM8 toolbox writes all files needed to create these templates (“DARTEL
export”), this requires only two additional steps. To calculate either non-modulated volumes (for grey
matter concentration), or volumes, which are modulated for the non-linear effect of normalization
only (for grey matter volume) an affine registration of the DARTEL export should be used. A rigid
registration can be considered, if the volumes should be modulated for linear and non-linear effects.
However, this will require a modification of the statistical model (see VBM8-Manual: “Additional
information on native, normalized and modulated volumes”). The workflows are depicted in Figure 2.

Affine Run Create
* registered DARTEL warped
VBMS8 toolbox: | —| GMand WM |_| (create | GM
Native segments Templates) segments
T1 - Segmen(‘;ation
Volumes an Normalize
affine OR rigid Rigid Run GM
registration —»| registered |=*| DARTEL >
segments
GM and WM (create
to MNI
segments Templates)
space

Fig 2.: Creating a customized DARTEL-template. Registered tissue segments from the VBMS8
Toolbox are taken to obtain the deformation fields via the DARTEL toolbox in SPM8. On top
(marked with red asterisk) is the option tha¥ accounts for brain size, which is the
recommended option.



Customized DARTEL-template using affine registered segmentations

This option uses affine registered GM and WM segments and modulates the segmentations for non-
linear effects only, which accounts for brain size. No additional normalization to MNI space is
necessary, because the DARTEL template is provided in that space. This option will create the
corresponding segments to the wrp[0 1 2 3] and mOwrp[0 1 2 3] output of the VBM8-Toolbox.

Module: “Estimate and Write”:

- ”Writing Options”
- “Grey Matter”-> “DARTEL export” - “affine”
- “White Matter”> “DARTEL export” - “affine”

The volumes “rp1*-affine.nii” and “rp2*-affine.nii” will be written. These are the grey (rpl) and white
(rp2) matter segments after an affine registration to the MNI template. The following modules can be
chosen directly in the batch editor (SPM - Tools > DARTEL Tools > Run DARTEL (create Templates),
and SPM - Tools > DARTEL Tools = create warped). It makes sense to add and specify these
modules together with the “Estimate and Write” module within the Batch Editor and to set
dependencies.

Module “Run DARTEL (create Templates)”

- Images -2 select two times “new: Images”
- Images: 2 select the “rp1*-affine.nii” files or create a dependency.
- Images: 2 select the “rp2*-affine.nii” files or create a dependency.

-> all other options: use defaults or modify

Module “create warped”

-> Flow fields = select all flow fields (one per volume, “u_*.nii”) or create dependency.
- Images 2 select “new: Images”
- Images: 2 select the “rp1*-affine.nii” files or create a dependency.
- Modulation: select “Pres. Amount (Modulation)” or “Pres. Concentration (No Modulation)”

-> all other options: use defaults or modify
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Customized DARTEL-template using rigidly registered segmentations

This option uses rigidly registered GM and WM segments and modulates for both linear and non-
linear effects. Thus segmentations are not corrected for brain size. It will create the corresponding
segments to the mwrp[0 1 2 3] output of the VBMS8-Toolbox. Although the other option is
recommended, it is described for completeness.

Module: “Estimate and Write”:

->”Writing Options”
- “Grey Matter”-> “DARTEL export” - “rigid”
- “White Matter”—> “DARTEL export” - “rigid”

The volumes “rp1*.nii” and “rp2*.nii” will be written. These are the grey (rpl) and white (rp2) matter
segments after rigid registration to the MNI template. Again, it makes sense to add and specify the
following modules together with the “Estimate and Write” module in the Batch Editor and to set
dependencies.

Module “Run DARTEL (create Templates)”

- Images -2 select two times “new: Images”
- Images: =2 select the “rp1*.nii” files or create a dependency.
- Images: =2 select the “rp2*.nii” files or create a dependency.

-> all other options: use defaults or modify

Module “Normalize to MNI Space”

- DARTEL Template = select the last DARTEL template created by “Run DARTEL (create
Templates)”. By default this will be “Template_6".

—> Select according to > select “many Subjects”
-> Flow fields = select all flow fields (one per volume, “u_*.nii”) or create dependency
- Images -2 select “new: Images”
- Images: =2 select the “rp1*-affine.nii” files or create a dependency.

- Modulation: select “Pres. Amount (Modulation)” or “Pres. Concentration (No Modulation)”
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- Gaussian FWHM -> select your smoothing kernel. No additional smoothing will be
necessary.

-> all other options: use defaults or modify

How to proceed:
All steps described above are just an adaption of the VBM8 Toolbox module “Estimate and Write”.

Except for the last option “Customized DARTEL-template using rigidly registered segmentations” a
subsequent smoothing is necessary before statistics can be calculated. As always it is a good idea to
save the applied modules and to perform quality control. Here, the modules “Display one slice for all
images” and “Check sample homogeneity using covariance” from the VBMS8 Toolbox will be helpful.

Additional information on native, normalized and modulated volumes

When preprocessing the images (see “First Module: Estimate and write”, on pages 5-6), the decision
about the normalization parameters will determine the interpretation of the analysis outcomes:

“Native space” produces tissue class images in spatial correspondence to the original data. Although
this could be useful for estimating global tissue volumes (e.g., GM+WM+CSF=TBV) it is not suitable to
conduct VBM analyses due to the missing voxel-wise correspondence across brains). Of note, if one is
interested in these global tissue volumes in native space (“raw values”), it won’t be necessary to
actually output the tissue class images in native space. The “Estimate and write”-function
automatically generates a text file for each subject (*_seg8.txt), which contains the raw values for
GM, WM, and CSF. The subject-specific values can be combined (i.e., integrated into a single text file)
by using the function “Calculate raw volumes for GM/WM/CSF”: VBM8 —> Tools = Calculate raw
volumes for GM/WM/CSF

“Normalized” produces tissue class images in spatial correspondence to the template. This is useful
for VBM analyses (e.g., “concentration” of gray matter; Good et al. 2001; Neuroimage).

“Modulated normalized” gives two different options:

. Affine+non-linear produces tissue class images in alignment with the template, but multiplies
(“modulates”) the voxel values by the Jacobian determinant (i.e., linear and non-linear
components) derived from the spatial normalization. This is useful for VBM analyses and allows
comparing the absolute amount of tissue (e.g., “volume” of gray matter; Good et al. 2001;
Neuroimage).

. Non-linear only produces tissue class images in alignment with the template, but multiplies the
voxel values by the non-linear components only. This is useful for VBM analyses and allows
comparing the absolute amount of tissue corrected for individual brain sizes. Of note, this option
is similar to using “Affine+non-linear” (see above) in combination with “global normalization”
(when later building the statistical model using the traditional PET designs). That is, when
building the statistics, one would specify “Global normalization” - “Overall grand mean scaling
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— No” = “Normalization — Proportional”. It is also similar to using “Affine+non-linear” (see
above) and including the numeric brain volume (as given in the *_seg8.txt file for each subject)
as covariate (when later building the statistical model). Although all 3 approaches allow
comparing tissue volumes while correcting for individual brain size, it is recommended to use
the option “non-linear only” as it applies the correction directly to the data, rather than to the
statistical model.

For further explanation see also:

http://dbm.neuro.uni-jena.de/vbm/segmentation/modulation

Naming convention of output files

segmented images: bias corrected images:
m[0]w[r]p[0123]* wm[r]*
m - modulated m - bias corrected
mO - modulated non-linear only w - warped
w - warped r - dartel warped
r - dartel warped
p - segmented estimated raw volumes:
0 - PVE label

pxxx_seg.txt
1 -GM
2 -WM
3 - CSF

_affine - affine registered only

Technical information

This toolbox is an extension of the “New Segment Toolbox” in SPMS8, but uses a completely different
segmentation approach.’

The segmentation approach is based on an adaptive Maximum A Posterior (MAP) technique
without the need for a priori information about tissue probabilities. That is, the Tissue
Probability Maps are not used constantly in the sense of the classical unified segmentation
approach, but just for spatial normalization®. The following MAP estimation is adaptive in the
sense that local variations of the parameters (i.e., means and variance) are modelled as slowly
varying spatial functions (Rajapakse et al. 1997). This not only accounts for intensity
inhomogeneities but also for other local variations of intensity.

Additionally, the segmentation approach uses a Partial Volume Estimation (PVE) with a
simplified mixed model of at most two tissue types (Tohka et al. 2004). We start with an initial
segmentation into three pure classes: gray matter (GM), white matter (WM), and
cerebrospinal fluid (CSF) based on the above described MAP estimation. The initial
segmentation is followed by a PVE of two additional mixed classes: GM-WM and GM-CSF. This

* The classic SPM8 segmentation is still used in addition, but only to initially remove non-brain tissue from the image.
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results in an estimation of the amount (or fraction) of each pure tissue type present in every
voxel (as single voxels — given by their size — probably contain more than one tissue type) and
thus provides a more accurate segmentation.

3. Furthermore, we apply two denoising methods. The first method is a spatially adaptive non-
local means (SANLM) denoising filter (Manjon et al. 2010). This filter will remove noise while
preserving edges and is implemented as preprocessing step. The second method is a classical
Markov Random Field (MRF) approach, which incorporates spatial prior information of
adjacent voxels into the segmentation estimation (Rajapakse et al. 1997).

4. Another important extension to the SPM8 segmentation is the integration of the Dartel
normalisation (Ashburner 2007) into the toolbox. If high-dimensional spatial normalisation is
chosen, an already existing Dartel template in MNI space will be used. This template was
derived from 550 healthy control subjects of the IXl-database (http://www.brain-
development.org) and is provided in MNI space4 for six different iteration steps of Dartel
normalisation. Thus, for the majority of studies the creation of sample-specific Dartel
templates is not necessary anymore”.
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4 ars . . .
Thus, no additional MNI normalization is necessary.

> For studies investigating data of children | still recommend creating a customized Dartel template. Of note, for this
option a representative sample with a sufficient number of subjects is required (n>50-100). Alternatively, if a sufficient
sample size cannot be achieved, the low-dimensional SPM8 normalization approach combined with customized Tissue
Probability Maps (e.g. from the TOMS toolbox) can be selected.
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